
 
 
 

 
 

LIYAN PROGRAMMABLE LOGIC CONTROLLER 
 
 
 
 
 
 

LYPLC 
EPeditor 

 
 
 

USER’S  MANUAL 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

(1) Setup software 
Execute EpEditor\setup.exe 
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Yes: Agree this software license agreement 
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Input user’s name and company 
 

 
Browse: change destination directory. If not change, system will set it as C:\Liyan\EpEditor 
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Choose program folder or add a new one. If not change, system will build a new folder as EpEditor. 
 

 
Confirm setup information. If need to change, press Back. 
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Setup Complete 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
(2) Overview 
 

 

Menu 

Tool Bar 

Object 

Frame Tree 
Edit screen 

Preview screen 
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Property setting 

PLC type HMI Type  Object Position Mouse PositionStatus bar 

 

 
 
 
 



 

(3) Function 
 

Button Function 

 New file 

 Open file 

 Save file 

 System setting 

 Create new screen 

 Copy screen 

 Delete screen 

 Zoom in 

 Zoom out 

 Move up object 

 Move down object 

 Move left object 

 Move right object 

 Compile program 

 Download program to HMI 

 Indicator 

 Button 

 Static text 

 Dynamic text 

 Numeric Entry 

 Buzzer 

 BitMap 

 PLC RUN 

 PLC STOP 
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(4) Programming steps 
1. New file  

Press  or select「file→New」. Input project name and select HMI/PLC type. 

 

When HMI Type is EP314, 
select combined PLC type 

When HMI Type is EP300, 
select connected PLC type 

 
2. System setting 

Press  or select「Option→System Setting」 

 

D register are used 

♦Screen No. Control: Change screen by D register. If Enable is selected, user can change screen by D register 
which is set.  

♦Date/Time Write to PLC: it is applicable to EP300 only. 
♦Close HMI Function: it is applicable to EP314 V1.56 or more 
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3. Screen property setting 

 

2 1 

3 

4 

1) Screen No.: Set this screen number. Screen No. is changed after input number and press ENTER key. 
2) Starting Screen No.: Set starting screen number  
3) Description: Describe this screen 
4) Screen-jump setting. Press Up or Down button, screen will jump from this screen to setting screen number 

 
4. Add components 
4-1 Indicator  

Press  or select「Components→Indicator」 

 
♦Device: Set monitored device 
♦ON Blinking: When device is set ON and this option is selected, indicator will be blinked. If this option is not 
selected, indicator will be lit. 
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4-2 Button (Function Key) 

Press  or select「Components→Function Key」 

 
♦Key: choose type of Function Key 
♦Hide: If button is set to hide, button’s frame will become to blue in edit screen.  
♦Function: 

Bit Control:  
Action:  
Momentary: when button of panel is pressed, device is ON; when button is not pressed, device is OFF. 

 Set ON: press button of panel once, device is ON 
 Set OFF: press button of panel once, device is OFF 
 Toggle: when press button of panel once, device is ON, and press it once again, device is OFF. 
 
Change Screen: jump to screen which is set. 
 
Set Constant: Write value to D register 

  Value length: select 16 bits or 32 bits  
  Value type: reserved 
 
 
 

11 



 

4-3 Static text 

Press  or select「Components→Static Text」 

 
♦Font Setting: Font size is able to be set (8 / 10 / 12 / 14 / 18 / 24) 
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4-4 Dynamic text 

Press  or select「Components→Dynamic Text」 

 

Value of device 

Displayed Text

♦Example: as this illustration, when D0=0, it will display DText. 
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4-5 Numeric Entry 

Press  or select「Components→Numeric Entry」 

 If this option is selected, after 
value is input, device will be ON.

♦Value Length: 16 bits or 32 bits 
♦Value Type: Signed / Unsigned / HEX (hexadecimal) 
♦Font Size: 8 / 10 /12 are selectable 
♦Input Enable: set range of value 
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4-6 Buzzer 

Press  or select「Components→Buzzer」 

 
♦If Intermittent is selected, buzzer will be ON about 0.5 sec. and be OFF about 0.5 sec. 
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4-7 Calendar 

Press  or select「Components→Calendar display」 

 
 
4-8 BitMap 

Press  or「Components→Bitmap」 

 
♦Open BitMap which is input 
♦User can input self-designed BitMap file to screen 
♦BitMap format: 128 x 64 dots, monochrome 
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5. Compile  

Press  or select「Tools→Compile」 

  
 
6. Download  

Press  or select「Tools→Download」 

 
♦Set communication port and BaudReate 
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7. Save file 

Press  or select「File→Save」 

 
♦When user saves file at the first time, system will save it to C:\Liyan\EpEditor\User if user does not assign it. 
 
8. Open file 

Press  or select「File→Open」 

 
♦File type: choose .Ep3 file 
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(5) PLC setting (Applicable to EP314) 
 
1. Device monitor 

 
♦Start monitor: Start to monitor device 
♦Stop monitor: Stop to monitor device 
♦Register devices: input monitored device 
 
2. Force On/Off 

 

Input device’s address 
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3. Change current value 

 
♦Device[D]: Input device’s address of D (D0~D8255) 
♦Value:  

16bits : Set K value (Range: K-32768~K32767) or H value (Range: H0000~FFFF) 
32bits : Set K value (Range: K-2147483648~K2147483647) or H value (Range: H00000000~FFFFFFFF) 

 
 
4. Keyword setting 

 
♦Set password: input it in New Keyword 
♦Change password: input Old Keyword first, and then input New Keyword 
 
5. Remote RUN/STOP 
♦Remote PLC RUN or STOP 
 
6. Set time 

 

♦Set time: Year, Month, Date, Hour, Minute, Second, Day(week) 
♦Start monitor: Start to monitor time 
 Stop monitor: Stop to monitor time 
 Setup: Write setting time. (When Setup, user has to stop monitor first) 
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7. One Day Control 

 

Set number of control 

♦Example: as this illustration, when time of Control On is up, M0 is ON; when time of Control Off is up, M0 is off. 
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8. Link Control 

 
♦Part 1: Setting of Protocol 
Protocol： Modbus ASCII or Modbus RTU are selectable 
Data bits： Modbus ASCII is 7. Modbus RTU is 8. 
Parity： None, Odd or Even. It is defined by user. It has to be as same as setting of slave. 
Stop bits： 1 or 2. It is defined by user. It has to be as same as setting of slave. 
Baud rate： 2400, 4800, 9600, 19200, 38400, 57600, 115200. It has to be as same as setting of slave. 
Format 1/4： Reserved 
Header： as default value 
Terminator1： as default value 
Terminator2： as default value 
Hardware： Reserved 
Control mode： Reserved 
Sum check： Reserved 
Station No.： as default value 
Timeout(.1ms)： Communication Time-out Time. The unit is 0.1ms 
 
♦Part 2: Setting of Auto Link 
Enable Auto Link Control： Enable if it is selected 
EnableMregister： It is controlled from Mregister. It is occupied 40 points totally from the start. 
StartDregister： It is controlled from Dregister. It is occupied 100 points totally from the start. 
Maximum Station No.： Total connected stations, i.e., number of slaves. The maximum is 32(*1). 
Data type： 8bits or 16bits. As default value 
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♦Part 3: Setting of access method 
Send Dreg start address： Start address of D register for send 
Space each station (send)： Assigned space of each slave (for send) 
Word count (send)：(*2) Number of word is sent to each slave. It can not more than “Space each station 
  (send)” 
Receive Dreg start address： Start address of D register for receive 
Space each station (receive)： Assigned space of each slave (for receive) 
Word count (receive)：(*3) Number of word is received from each slave. It can not more than “Space each 
 station(receive) 
Wait Time (0.1ms)： Wait time. The unit is 0.1ms 
*1：Station number of slave has to be started from 1, and it has to be continuous. 
*2：If number of Send is 0, then it will not execute to send, and it is unable to use broadcast function. 
*3：If number of Receive is 0, then it will not execute to receive. Number of Send and Receive can not be 0 at the 
   same time.  

 
♦Part 4: Button of Help  
Press “Help”, it will show occupied situation of Mregister and Dregister 

In above 

example, EnableMregister is set as M900 
M900: Start/Stop flag. M900 ON, communication is started. M900 OFF, communication is stopped (*4) 
M901-M932: receive finish flag (total 32 points). M901 is Slave 1, M902 is Slave 2…and so on. User has to clear it 
manually. 
M933: flag of send broadcast signal. (*5) 
M934: Broadcast busy flag 
M935: Broadcast finish flag. It will be ON after complete to send broadcast signal, and user have to clear it manually. 
 
In above example, StartDregister is set as D900 
D900-D931: Parameter of auto link control 
D900: Communication Format 
D901: Communication Command 
D903: Communication Timeout Timer 
D918: Number of total connected stations 
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D919: Current station number in communication 
D920: Start address for receive data 
D922: Start address for send data 
D932-D963: address for reading from slave 
D964-D995: address for writing to slave 
D996-D999: System reserved 
*4：Communication is working by turns, i.e., it is communicated from slave 1, and then slave 2…and so on. Until to 

 maximum station number, it will be communicated from slave 1 continuously.  
*5：It will send data to each slave at the same time through broadcast function, but each slave will not send it back. 

 
♦Part 5: Address for reading from slave 
This column is for setting to read data to EP314 from which address of each slave. 
Address of each station can be selected as decimal (DEC) or hexadecimal (HEX). 
If reading addresses of each slave are the same, only fill in address to station number 1 (StNo01) and press button 
of “Fill ALL”. 
 
♦Part 6: Address for writing to slave  
This column is for setting to write data from EP314 to which address of each slave. 
Address of each station can be selected as decimal (DEC) or hexadecimal (HEX).  
If writing addresses of each slave are the same, only fill in address to station number 1 (StNo01) and press button of 
“Fill ALL”. 
Note：If there is a wrong value in parameter setting, bottom color of the column will become to yellow color.  
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9. Axes Control 
9-1 JOG control 

 
♦Part 1 
To enable Axis1 JOG function (enable if it is selected) and to set start number of controlled registers. To press Help 
button is able to check occupied situation of registers if user change start number。 
 
♦Part 2 
Parameter of Axis1. Have to set maximum speed, bias speed, and Acceleration/deceleration time (Separate 
acceleration and deceleration is ineffective). 
 
♦Part 3 
To enable Axis2 JOG function (enable if it is selected) and to set start number of controlled registers. To press Help 
button is able to check occupied situation of registers if user change start number。 
 
♦Part 4 
Parameter of Axis2. To set maximum speed, bias speed, and Acceleration/deceleration time (Separate acceleration 
and deceleration is ineffective). 
 
♦Part 5 
Help button. Help frame will be appeared if press button once. It will show occupied situation of registers and special 
function registers which are related to axes control. 
 

25 



 

<Occupied situation of M register and D register> 

 

M8196: Axis1 JOG forward busy flag 
M8197: Axis2 JOG forward busy flag 
M8198: Axis1 JOG reverse busy flag 
M8199: Axis2 JOG reverse busy flag 
 
Axis1(Y0) occupies M500-M509 and D100-D109 
M500: Axis1 forward enable flag 
M501: Axis1 reverse enable flag (forward flag and reverse flag can not be ON at the same time) 
M502: Axis1 busy flag. When it is ON, it means Axis1 is operating. 
M503: Axis1 without slope stop flag 
[D103, D102]: Axis1 output frequency. It is ineffective to change value during operation.  
Bias speed≦Output frequency≦Maximum speed 
 
Axis2(Y1) occupies M510-M519 and D110-D119 
M510: Axis2 forward enable flag  
M511: Axis2 reverse enable flag (forward flag and reverse flag can not be ON at the same time)  
M512: Axis2 busy flag. When it is ON, it means Axis2 is operating  
M513: Axis2 without slope stop flag 
[D113, D112]: output frequency. It is ineffective to change value during operation. 
Bias speed≦Output frequency≦Maximum speed 
 
Except the above-mentioned registers, others are reserved in the occupied M and D registers, please do not use. 
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<Special function register are related to axes control> 

 
[D8137, D8136] : Axis1 target relative position 
[D8139, D8138] : Axis2 target relative position 
[D8141, D8140] : Axis1 current absolute position 
[D8143, D8142] : Axis2 current absolute position 
[D8145, D8144] : Axis1 relative position movement 
[D8147, D8146] : Axis2 relative position movement 
[D8157, D8156] : Axis1 maximum speed (pps) 
[D8159, D8158] : Axis2 maximum speed (pps) 
[D8161, D8160] : Axis1 current speed (pps) 
[D8163, D8162] : Axis2 current speed (pps) 
[D8164] : Axis1 acceleration/deceleration time (ms) 
[D8165] : Axis1 deceleration time (ms). It is effective when M8150 ON. 
[D8166] : Axis2 acceleration/deceleration time (ms) 
[D8167] : Axis2 deceleration time (ms). It is effective when M8151 ON. 
[D8168] : Axis1 bias speed (pps) 
[D8169] : the number of times of search servo Z phase for Axis1 
[D8170] : Axis2 bias speed (pps) 
[D8171] : the number of times of search servo Z phase for Axis2 
 
♦Others : Instruction format and occupied registers 
pls:Y0 means Y0 is pulse output point 
dir:Y2 means Y2 is direction output point 
Axis1 Position D 100 : number of output pulses (This parameter is ineffective to JOG function) 
Axis1 Speed D 102(32bit) : output frequency. It is ineffective to change value during operation. Bias speed≦Output 
frequency≦Maximum speed 
 
pls:Y1 means Y1 is pulse output point 
dir:Y3 means Y3 is direction output point 
Axis2 Position D 110 : number of output pulses (This parameter is ineffective to JOG function) 
Axis2 Speed D 112(32bit) : output frequency. It is ineffective to change value during operation. Bias speed≦Output 
frequency≦Maximum speed 
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9-2 ZRN control  

 
♦Part 1 
To enable Axis1 Zrn Control function (enable if it is selected) and to set start number of controlled registers. To press 
Help button is able to check occupied situation of registers if user change start number。 
 
♦Part 2 
Parameter of Axis1. Have to set maximum speed, bias speed, and Acceleration/deceleration time (Separate 
acceleration and deceleration is ineffective). 
 
♦Part 3 
To enable Axis2 Zrn Control function (enable if it is selected) and to set start number of controlled registers. To press 
Help button is able to check occupied situation of registers if user change start number。 
 
♦Part 4 
Parameter of Axis2. Have to set maximum speed, bias speed, and Acceleration/deceleration time (Separate 
acceleration and deceleration is ineffective). 
 
♦Part 5 
Help button. Help frame will be appeared if press button once. It will show occupied situation of registers and special 
function registers which are related to axes control. 
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<Occupied situation of M register and D register> 

 
Axis1(Y0) occupies M520-M529 and D120-D129 
M520 : Axis1 Zero-Return enable flag 
M522 : Axis1 Zero-Return busy flag 
M523 : Axis1 without slope stop flag 
M527 : Axis1 Zero-Return finish flag 
[D121, D120] : search Home Speed. It is ineffective to change value during operation. 
Bias speed≦Home speed≦Maximum speed 
[D123, D122] : search Creep Speed. It is ineffective to change value during operation. 
Bias speed≦Creep Speed≦32767 pps 
 
Axis2(Y1) occupies M530-M539 and D130-D139 
M530 : Axis2 Zero-Return enable flag 
M532 : Axis2 Zero-Return busy flag 
M533 : Axis2 without slope stop flag 
M537 : Axis2 Zero-Return finish flag 
[D131, D130] : search Home Speed. It is ineffective to change value during operation. 
Bias speed≦Home speed≦Maximum speed 
[D133, D132] : search Creep Speed. It is ineffective to change value during operation. 
Bias speed≦Creep speed≦32767 pps 
 
Except the above-mentioned registers, others are reserved in the occupied M and D registers, please do not use. 
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<Special function register are related to axes control> 

 
[D8137, D8136] : Axis1 target relative position 
[D8139, D8138] : Axis2 target relative position 
[D8141, D8140] : Axis1 current absolute position 
[D8143, D8142] : Axis2 current absolute position 
[D8145, D8144] : Axis1 relative position movement 
[D8147, D8146] : Axis2 relative position movement 
[D8157, D8156] : Axis1 maximum speed (pps) 
[D8159, D8158] : Axis2 maximum speed (pps) 
[D8161, D8160] : Axis1 current speed (pps) 
[D8163, D8162] : Axis2 current speed (pps) 
[D8164] : Axis1 acceleration/deceleration time (ms) 
[D8165] : Axis1 deceleration time (ms). It is effective when M8150 ON. 
[D8166] : Axis2 acceleration/deceleration time (ms) 
[D8167] : Axis2 deceleration time (ms). It is effective when M8151 ON.  
[D8168] : Axis1 bias speed (pps) 
[D8169] : the number of times of search servo Z phase for Axis1 
[D8170] : Axis2 bias speed (pps) 
[D8171] : the number of times of search servo Z phase for Axis2 
 
♦Part 6 
To set input point of DogPoint, number of times of search servo Z phase, and return mode (refer to next page) for 
Axis1 Zrn Control function. X0 is Z phase input point for Axis1. It can set one point of X2~X7 for input point of 
DogPoint, but it can not set same point as Axis2.  
 
♦Part 7 
To set input point of DogPoint, number of times of search servo Z phase, and return mode (refer to next page) for 
Axis 2 Zrn Control function. X1 is Z phase input point for Axis2. It can set one point of X2~X7 for input point of 
DogPoint, but it can not set same point as Axis1. 
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♦Others : Instruction format and occupied registers 
pls:Y0 means Y0 is pulse output point  
dir:Y2 means Y2 is direction output point  
Axis1 HomeSpeed D 120(32bit) : search Home speed. Bias speed≦Home speed≦Maximum speed 
Axis1 CreepSpeed D 122(32bit) : search Creep speed. Bias speed≦Creep speed≦32767 pps 
 
pls:Y1 means Y1 is pulse output point  
dir:Y3 means Y3 is direction output point  
Axis2 HomeSpeed D 130(32bit) : search Home speed. Bias speed≦Home speed≦Maximum speed 
Axis2 CreepSpeed D 132(32bit) : search Creep speed. Bias speed≦Creep speed≦32767 pps 
 
♦Note : Return mode 

If number of times of search servo Z phase is set to 0, then it will not search Z phase. 
<Forward mode> 
Forward-L : initial operation direction : reverse 
Forward-R : initial operation direction : forward 

3 
In forward mode, if it meets DogPoint, then it will decelerate to CreepSpeed and start to search Z phase. If 
number of times of Z phase is 0, it will stop.  

Start to search servo Z phase Start to search servo Z phase 

DogPoint DogPoint 

Initial position Initial position

 
<Reverse mode> 
Reverse-L : initial operation direction : reverse 
Reverse-R : initial operation direction : forward 

 

Start to search 
servo Z phase 

Start to search 
servo Z phase

Reverse mode – forward : When it meets DogPoint at the first time, it decelerates to CreepSpeed and then 
reverse. When it meets DogPoint at the second time, it starts to search Z phase. If number of times of Z phase 
is 0, it will stop. 
Reverse mode – reverse : When it meets DogPoint at the first time, it decelerates to CreepSpeed and then 
forward. When it meets DogPoint at the second time, it keeps as CreepSpeed and then reverse. When it meets 
DogPoint at the third time, it starts to search Z phase. If number of times of Z phase is 0, it will stop.  
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9-3 Increment control  

 
♦Part 1 
To enable Axis1 Increment Control function (enable if it is selected) and to set start number of controlled registers. To 
press Help button is able to check occupied situation of registers if user change start number。 
 
♦Part 2 
Parameter of Axis1. Have to set maximum speed, bias speed, acceleration time and deceleration time. 
 
♦Part 3 
To enable Axis2 Increment Control function (enable if it is selected) and to set start number of controlled registers. To 
press Help button is able to check occupied situation of registers if user change start number。 
 
♦Part 4 
Parameter of Axis2. Have to set maximum speed, bias speed, acceleration time and deceleration time. 
 
♦Part 5 
Help button. Help frame will be appeared if press button once. It will show occupied situation of registers and special 
function registers which are related to axes control. 
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<Occupied situation of M register and D register> 

 
Axis1(Y0) occupies M540-M549 and D140-D149 
M540 : Axis1 Increment position enable flag 
M542 : Axis1 busy flag 
M547 : Axis1 Increment position finish flag 
[D141, D140] : number of Axis1 output pulses. It is ineffective to change value during operation. If value is positive, 
then it outputs forward pulse. If value is negative, then it outputs reverse pulse. 
[D143, D142] : Axis1 output frequency. It is ineffective to change value during operation.。Bias speed≦Output 
frequency≦Maximum speed 
 
Axis2(Y1) occupies M550-M559 and D150-D159 
M550 : Axis2 Increment position enable flag 
M552 : Axis2 busy flag 
M557 : Axis2 Increment position finish flag 
[D151, D150] : number of Axis2 output pulses. It is ineffective to change value during operation. If value is positive, 
then it outputs forward pulse. If value is negative, then it outputs reverse pulse. 
[D153, D152] : Axis2 output frequency. It is ineffective to change value during operation.。Bias speed≦Output 
frequency≦Maximum speed 
 
Except the above-mentioned registers, others are reserved in the occupied M and D registers, please do not use. 
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<Special function register are related to axes control> 

 
[D8137, D8136]：Axis1 target relative position 
[D8139, D8138]：Axis2 target relative position 
[D8141, D8140]：Axis1 current absolute position 
[D8143, D8142]：Axis2 current absolute position 
[D8145, D8144]：Axis1 relative position movement 
[D8147, D8146]：Axis2 relative position movement 
[D8157, D8156]：Axis1 maximum speed (pps) 
[D8159, D8158]：Axis2 maximum speed (pps) 
[D8161, D8160]：Axis1 current speed (pps) 
[D8163, D8162]：Axis2 current speed (pps) 
[D8164]：Axis1 acceleration/deceleration time (ms) 
[D8165]：Axis1 deceleration time (ms). It is effective when M8150 ON. 
[D8166]：Axis2 acceleration/deceleration time (ms) 
[D8167]：Axis2 deceleration time (ms). It is effective when M8151 ON.  
[D8168]：Axis1 bias speed (pps) 
[D8169]：the number of times of search servo Z phase for Axis1  
[D8170]：Axis2 bias speed (pps) 
[D8171]：the number of times of search servo Z phase for Axis2 
 
♦Others : Instruction format and occupied registers 
pls:Y0 means Y0 is pulse output point  
dir:Y2 means Y2 is direction output point  
Axis1 Position D140(32bit) : number of output pluses. It is ineffective to change value during operation. If value is 
positive, then it outputs forward pulse. If value is negative, then it outputs reverse pulse.  
Axis1 Speed D 142(32bit) : output frequency. It is ineffective to change value during operation. Bias speed≦Output 
frequency≦Maximum speed 
 
pls:Y1 means Y1 is pulse output point  
dir:Y3 means Y3 is direction output point  
Axis2 Position D 150(32bit) : number of output pluses. It is ineffective to change value during operation. If value is 
positive, then it outputs forward pulse. If value is negative, then it outputs reverse pulse. 
Axis2 Speed D 152(32bit) : output frequency. It is ineffective to change value during operation. Bias speed≦Output 
frequency≦Maximum speed 
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9-4 Absolute control 

 
♦Part 1 
To enable Axis1 Absolute Control function (enable if it is selected) and to set start number of controlled registers. To 
press Help button is able to check occupied situation of registers if user change start number。 
 
♦Part 2 
Parameter of Axis1. Have to set maximum speed, bias speed, acceleration time and deceleration time. 
 
♦Part 3 
To enable Axis2 Absolute Control function (enable if it is selected) and to set start number of controlled registers. To 
press Help button is able to check occupied situation of registers if user change start number。 
 
♦Part 4 
Parameter of Axis2. Have to set maximum speed, bias speed, acceleration time and deceleration time. 
 
♦Part 5 
Help button. Help frame will be appeared if press button once. It will show occupied situation of registers and special 
function registers which are related to axes control. 
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<Occupied situation of M register and D register> 

 
Axis1(Y0) occupies M560-M569 and D160-D169  
M560 : Axis1 absolute position enable flag 
M562 : Axis1 busy flag 
M567 : Axis1 absolute position finish flag 
[D161, D160] : Axis1 target position. It is ineffective to change value during operation. 
[D163, D162] : Axis1 output frequency. It is ineffective to change value during operation.。Bias speed≦Output 
frequency≦Maximum speed 
 
Axis2(Y1) occupies M570-M579 and D170-D179 
M570 : Axis2 absolute position enable flag 
M572 : Axis2 busy flag 
M577 : Axis2 absolute position finish flag 
[D171, D170] : Axis2 target position. It is ineffective to change value during operation. 
[D173, D172] : Axis2 output frequency. It is ineffective to change value during operation.。Bias speed≦Output 
frequency≦Maximum speed 
 
Except the above-mentioned registers, others are reserved in the occupied M and D registers, please do not use. 
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<Special function register are related to axes control> 

 
[D8137, D8136] : Axis1 target relative position 
[D8139, D8138] : Axis2 target relative position 
[D8141, D8140] : Axis1 current absolute position 
[D8143, D8142] : Axis2 current absolute position 
[D8145, D8144] : Axis1 relative position movement 
[D8147, D8146] : Axis2 relative position movement 
[D8157, D8156] : Axis1 maximum speed (pps) 
[D8159, D8158] : Axis2 maximum speed (pps) 
[D8161, D8160] : Axis1 current speed (pps) 
[D8163, D8162] : Axis2 current speed(pps) 
[D8164] : Axis1 acceleration/deceleration time (ms) 
[D8165] : Axis1 deceleration time (ms). It is effective when M8150 ON.  
[D8166] : Axis2 acceleration/deceleration time (ms) 
[D8167] : Axis2 deceleration time (ms). It is effective when M8151 ON.  
[D8168] : Axis1 bias speed (pps) 
[D8169] : the number of times of search servo Z phase for Axis1 
[D8170] : Axis2 bias speed (pps) 
[D8171] : the number of times of search servo Z phase for Axis2 
 
♦Others : Instruction format and occupied registers 
pls:Y0 means Y0 is pulse output point  
dir:Y2 means Y2 is direction output point  
Axis1 Position D 160(32bit) : target position. It is ineffective to change value during operation. 
Axis1 Speed D 162(32bit) : output frequency. It is ineffective to change value during operation.。Bias speed≦Output 
frequency≦Maximum speed 
 
pls:Y1 means Y1 is pulse output point 
dir:Y3 means Y3 is direction output point  
Axis2 Position D 170(32bit) : target position. It is ineffective to change value during operation. 
Axis2 Speed D 172(32bit) : output frequency. It is ineffective to change value during operation.。Bias speed≦Output 
frequency≦Maximum speed 
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